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Touchpad iPRIME (2.2)

 �Categories of Computers and  
Computer Languages

OneOne LearnTouch

A.	 1.	 a.	 2.	 b.	 3.	 d.	 4.	 c.	 5.	 a.

B.	 1.	 F	 2.	 F	 3.	 F	 4.	 F	 5.	 T

C.	 1.	 Microcomputer		  2.	 Laptop	 3.	 Instructions

	 4.	 Programming			   5.	 Assembler

ItLet's Do

A.	 1.	 A minicomputer can contain one or more microprocessors as its processing units. This type 
of computer is mainly used for scientific and engineering computations. A minicomputer 
has the capability to serve a number of users simultaneously.

	 2.		 An embedded computer is a special type of microprocessor-based system that is developed 
for performing a specific task.

	 3.	 C and BASIC are the types of 3GL.

	 4.	 An assembler is a program used to translate assembly language into machine language 
so that the computer can understand it.

	 5.		 A computer language is the medium by which instructions are transmitted to the computer 
to perform a specific task. It is a set of words, symbols and codes that the computer can 
understand.

B.	 1.	 A hand held computer is a type of computer that can easily be stored in our pocket and 
used by holding it in our hands. Most handheld computers have a touchscreen on which 
data can be input using our fingers. Two examples of handheld computers are smartphones 
and smartwatches.

1.
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	 2.		 Digital computer refers to a computer that uses digits (binary numbers 0’s and 1’s) to 
generate, process, and display data. The results produced by digital computers are more 
accurate than those of analog computers. All the modern computers that we use, like 
desktops, laptops, and smartphones are the examples of digital computers. 

	 3.	 The differences between HLL and LLL are:

HLL LLL
Machine-independent, meaning programs 
can run on different types of computers. 

Machine-dependent, meaning programs 
run only on specific types of computers.

Easier to read, write, and maintain as it is 
closer to human language. 

Difficult to understand because it is 
closer to machine language.

Programs are portable and can be used on 
different computers.

Programs are not easily portable and 
work only on a specific system.

Includes third-generation, fourth-generation, 
and natural languages (e.g., Python, Java).

Includes machine language and assembly 
language (e.g., binary code, assembly 
code).

	 4.	 Advantages of High-Level Languages 

	 	 	 A high-level language is user-friendly. 

	 	 	� A high-level language is similar to the English language with its vocabulary of words and 
symbols, making it easier to understand and use for programming. 

	 	 	� A high-level language requires less time to write a program. 

	 	 	 A high-level language is easier to maintain. 

	 	 	 A high-level language is problem-oriented rather than machine-based. 

	 	 	� Programs written in a high-level language can be translated into machine language and 
therefore it can be run on any computer with an appropriate translator. 

	 	 	� A high-level language is machine-independent i.e., programs developed in high-level 
languages can be run on any computer. 

C.	 1.	� Yes, Mini is correct because a washing machine has an embedded computer inside it. An 
embedded computer is a special type of microprocessor-based system that is developed for 
performing a specific task. Today, embedded computers are used in various applications. 

	 2.	� Reena explained that computer languages have generations based on their evolution. 
First-generation is machine language (binary), second-generation is assembly language,  
third-generation includes high-level languages like C and Java, fourth-generation is  
user-friendly languages like SQL, and fifth-generation focuses on AI and natural language 
processing.
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Higher Order Thinking Skills (HOTS) 

1.	 Difference between Compiler and Interpreter:

	 	� A compiler translates the entire program at once into machine code before execution. (e.g., 
C, C++)

	 	 An interpreter translates and executes the program line by line. (e.g., Python, JavaScript)

2.	� We do not use Mini or Mainframe Computers at home because they are large, expensive, and 
designed for handling complex tasks like business and scientific applications. Microcomputers 
(like desktops and laptops) are affordable, compact, and sufficient for home use.
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 File Management—Organisation of Data

OneOne LearnTouch

A.	 1.	 b.	 2.	 c.	 3.	 c.	 4.	 a.	 5.	 a.
B.	 1.	 F	 2.	 T	 3.	 F	 4.	 F	 5.	 T
C.	 1.	 Format	 2.	 Sorting 	 3.	 .pptx	 4.	 Partitions 	 5.	 Asterisk 

ItLet's Do

A.	 1.	 Data on a computer can be arranged in the form of files or folders. 
	 2.	 Sorting means arranging the files and folders on the computer by type, size, name, and 

date of creation or modification.
	 3.	 Examples of file extensions are .docx and .pptx. 
	 4.	 Asterisk(*) and question mark(?) are the types of wildcard characters.
	 5.	 ‘Show windows side by side’ option is used to display multiple applications windows on 

the screen simultaneously. 
B.	 1.	 While searching, an Asterisk is used to replace a string of characters in the search term. 

It represents one or more characters in the string. Whereas a Question mark replaces a single 
character or symbol. It represents only one character, so it searches for only one character. 

	 2.	 File Explorer helps us organise and manage files and folders. It allows us to move or copy 
a file or folder from one drive to another, from one device to another, or from a pen drive 
to a computer.

	 3.	 The steps to sort the files as per Size are as follows:
		  Step 1	� Browse to the location where you want to sort the files and folders. 
		  Step 2	 Click on the Sort by command under the Current view group of the View tab. A 

drop-down menu appears. 
		  Step 3	 Select the Size option from the drop-down menu. 
		  The files will be arranged as per the size of the files.
	 4.	 When we work on a computer, we might need to work on more than one files at a time or 

open more than one application at a time. For example, while working in a Word file, we 
would be using Google for searching notes and PowerPoint for making presentation. If we 
need some images for the presentation, we would have the image folder open in Windows 
Explorer as well. As we know, all these applications would be open in separate windows. If 
we want, we can display two or more application windows side by side for easier work. 

	 5.	 When we copy a file from folder A to folder B, the original file remains at the original location 
(Folder A) and a duplicate of it is created to a new location (Folder B). Whereas when we 
move a file from folder A to folder B, the file is removed from its original location (Folder 
A) and moved to a new location (Folder B). 

2.
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C.	 1.	� Aayat can identify the files by checking their file extensions. A presentation file will have 
the .pptx extension, while a Word file will have the .docx extension.

	 2.	 The steps to sort the files as per name are as follows: 
		  Step 1	� Browse to the location where you want to sort the files and folders.
		  Step 2	� Click on the Sort by command under the Current view group of the View tab. A 

drop-down menu appears.
		  Step 3	� Select the Name option from the drop-down menu.
		  Now, all files starting with “HW” will appear together, making it easier for him to find his 

homework files quickly.

Higher Order Thinking Skills (HOTS) 

1.	 �To search for a file that starts with ‘k’ and ends with ‘d’, you can use the asterisk (*) wildcard, 
which represents any number of characters in between. The search query will be:

k*d

2.	 Importance of File Formats:

	 	� Identifies the File Type: File formats help the computer recognize whether a file is a document 
(.docx), image (.jpg), video (.mp4), etc., so it can be opened with the correct program.

	 	� Ensures Compatibility: Using the right format allows files to be shared and opened on 
different devices or software (e.g., PDFs can be opened on almost any device).
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Do it yourself.

 Word Processor—Tabular Representation

OneOne LearnTouch

A.	 1.	 b.	 2.	 b.	 3.	 c.	 4.	 a.	 5.	 a.
B.	 1.	 F 	 2.	 T	 3.	 T	 4.	 F	 5.	 F
C.	 1.	 Resizing  	 2.	 Merging  	 3.	 Layout  	 4.	 Design  	 5.	 Delete Rows

ItLet's Do

A.	 1.	 The intersection of a row and a column in a table is called a cell. 
	 2.	 Table Styles is a feature with which a user can format the entire table quickly.
	 3.	 Shading is an option to apply colours to cell or group of cells in a table.
B.	 1.	 To add a row in a table, follow these steps:
		  Step 1	 Click on the row of the table where you want to add another row.
		  Step 2	 Click on the Layout tab.
		  Step 3	� Choose Insert Above or Insert Below command. A blank row will be added at the 

required place in the table.
	 2.		 To insert a table, follow these steps:

		  Step 1	 Click on the Insert tab.

		  Step 2	 Click on the Table command in the Tables group.

		  Step 3	 Click on the Insert Table option. The Insert Table dialog box will appear.

		  Step 4	 Enter the required number of columns and rows you want to insert.

		  Step 5	 Click on OK button. The table will be inserted.

	 3.	 To merge two or more cells, follow these steps:

		  Step 1	 Select the cells to be merged.

		  Step 2	 Click on the Layout tab.

	 	 Step 3	 Click on the Merge Cells command. 

		  The selected cells are merged into one cell.

3.
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	 4.	 Splitting cells in a table refers to dividing one cell into two or more cells, whereas Merging 
cells in a table refers to combining two or more cells in the same row or same column into 
a single cell. 

C.	 1. 	 Aman should use Table option to organise the data in easy to read method.
	 2.	� Ms Shalini should use the “Merge Cells” option to combine the top row across all columns 

and add the heading.

Higher Order Thinking Skills (HOTS) 

	 1.	 To apply a border, follow these steps: 
		  Step 1	 Select the desired cells, rows, or columns to which you want to apply the border. 
		  Step 2	 Click on the Borders command of the Borders group under the Design tab. 
	 	 Step 3	 Select a type of border from the list. 
	 	 Step 4	� If you want to change the style of border, click on Borders command and then 

select the Borders and Shading option to open the Borders and Shading dialog 
box.

		  Step 5	 Select the style, colour and width of your border. 
		  Step 6	 Click on the OK button. 
			   The border style will be applied to the selected table. 
	 2.	 We find the AutoFit Contents option under the Table Tools Layout tab in Word, in the Cell 

Size group.
		  We use it to automatically adjust the column widths so that they fit the content inside the 

cells neatly, improving the table’s readability and appearance.

Crack CodeThe

A.	 1.	 Deletes the entire table from the document.
	 2. 	 Adds a new row directly above the selected row.
	 3.	 Adds a new row directly below the selected row.
	 4.	 Adds a new column to the left of the selected column.
	 5.	 Adds a new column to the right of the selected column.
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 Word Processor—Mail Merge

OneOne LearnTouch

A.	 1.	 a.	 2.	 b.	 3.	 d.
	 4.	 c.	 5.	 a.
B.	 1.	 T	 2.	 F	 3.	 F	 4.	 T
C.	 1.	 Mail merge			   2.	 Main document
	 3.	 Mailings			   4.	 Write and insert fields

ItLet's Do

A.	 1.	 Data source is a separate file that contains all information about recipients of the letter.
	 2.	 The name of the command used to add address list is Type a New List.
	 3.	 Preview Results command is used to see the preview of the merged letters.

4.
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B.	 1.	 Four advantages of Mail Merge are:

	 (i)	 It saves time and efforts.

	 (ii)	 It allows to make changes in several letters very quickly.

	 (iii)	It allows to produce thousands of letters quickly.

	 (iv)	It allows to save the letters as template for later use.

	 2.	 There are three main components of Mail Merge in Word which are as follows:

	 (i)	� Main Document: It is a document that contains the text of the letter which we want 
to send to our friends.

	 (ii)	� Data Source: It is a separate file that contains all information about recipients of the 
letter 

	 (iii)	� Merged Document: It is the final document created by merging the Main Document 
and Data Source. It contains a list of letters with text and details of a person.

	 3.	 Merged Document is the final document created by merging the Main Document and Data 
Source. It contains a list of letters with text and details of a person.

C.	 1.	 Rita should use the Mail Merge feature of Word to achieve this.

	 2.	 Gunjan can use the “Edit Individual Documents” option from Finish & Merge group under 
the Mailings tab, which opens a new document containing all the merged letters, each on 
a separate page. This allows her to edit specific letters individually and add a special line 
for her friends’ group according to her taste.

Higher Order Thinking Skills (HOTS) 
	 1.	 Merged Document is the final document created by merging the Main Document and Data 

Source. It contains a list of letters with text and details of a person. 
	 2.	 The three ways of selecting recipients for Mail Merge are:
		  a. Type a New List
		  b. Use an Existing List 
		  c. Choose from Outlook Contacts
What are the three ways of selecting recipients for Mail Merge?
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 Presentation—Visual Effects

OneOne LearnTouch

A.	 1.	 b.	 2.	 a.	 3.	 b.	 4.	 c. 	 5.	 a.	 6.	 b.
B.	 1.	 F	 2.	 F	 3.	 F	 4.	 T	 5.	 T
C.	 1.	 Insert video 	 2.	 Slide  	 3.	 Action Settings  	
	 4.	 Object	 5.	 Create

ItLet's Do

A.	 1.	 Slide Show view allows to view the presentation in full screen mode.
	 2.	 Slide Sorter View shows all the slides of a presentation in a miniature version and allows 

to change their order. 

5.



11 Touchpad iPRIME (Ver. 2.2)-VI (Answer Key)

	 3.	 Slide transition determines how presentation moves from one slide to next, whereas 
Animation is the addition of special  visual/sound effects to the text and graphics in a 
slide.

B.	 1.	 To insert sound to a presentation, follow these steps:

	 	 Step 1	 Click on the Audio → Audio on My PC command from the Media group of the 
Insert tab to open the Insert Audio dialog box.

		  Step 2	 Navigate and select the audio file to be inserted and click on the Insert button.

			   This will insert a speaker icon on the slide.

		  Step 3	 Click on button to listen to the audio.

	 2.	 Action button is used to move from one slide to another and play media files. We can also 
assign a particular task to be done when the viewer of the presentation clicks on an action 
button. There are 12 different types of action buttons are available in PowerPoint.

	 3.	 Four views in PowerPoint are:

	 a.	 Slide Sorter View

	 b.	 Notes Page View

	 c.	 Reading View 

	 d.	 Slide Show View

C.	 1.	 Rohan can use Action button feature of PowerPoint to achieve this.

	 2.	 Pooja should use Animation feature of PowerPoint to do this.

Higher Order Thinking Skills (HOTS) 

	 1.	 For this Notes Page view should be use as in this view, the slide of your presentation and 
the speaker notes that you have added within the Notes pane for each individual slide 
appear together. 

	 2.	 To insert a saved picture, follow these steps:

		  Step 1	 Click on the Insert tab. 

		  Step 2	 Click on the Pictures command in the Images group. The Insert Picture dialog 
box appears. 

		  Step 3	 Select the desired image file and click on the Insert button to add it to your slide.

			                 The selected picture gets inserted into the slide. 
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Worksheet-1

(Based on chapters 1 to 5)

A.	 1.	 Desktop		  Laptop
	 2.	 PDP-11		  PDP-8
	 3.	 ATM		  Microwave
	 4.	 Smartphone		  Smartwatch
B.	 1.	 The process of writing a program is called programming.
	 2.	 Wildcard character is a special character which is used to represent one or more characters 

and is commonly used for searching files/folders in a system.
	 3.	 A file extension is a group of two or more characters used to identify the type of a file.
	 4.	 Splitting cells refers to dividing one cell into two or more cells.
	 5.	� The Mail Merge feature in MS Word is used to create personalised letters to be sent to 

many people.
	 6.	 Notes pane is the area where a speaker can write notes for himself.

C.	 1.	 Tables		  Insert
	 2.	 Cell size		  Layout (Table Tools)
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	 3.	 Cell size		  Layout (Table Tools)
	 4.	 Merge		  Layout (Table Tools)
	 5.	 Table styles		  Design (Table Tools)

D.	 1.	 Hybrid Computer
	 2.	 Natural Languages
	 3.	 Assembler
	 4.	 Clipboard
	 5.	 Resize Handle
	 6.	 Data Source
	 7.	 Animation
	 8.	 Slide Sorter View

Test Sheet–1
(Based on chapters 1 to 5)

Section A
A.	 1.	 c.	 2.	 d.	 3.	 c.	 4.	 c.
	 5.	 d.	 6.	 c.	 7.	 d.	 8.	 d.
B.	 1.	 Minicomputer	 2.	 Microcomputer	 3.	 fifth
	 4.	 MP4	 5.	 Borders and shading	 6.	 Mailings
C.	 1.	 T	 2.	 T	 3.	 T	 4.	 T	 5.	 T

Section B
A.	 1.	 A smartwatch is a computing device which you can wear on your wrist. It provides the 

features of an older watch and some advanced features of smartphone like connecting to 
the Internet, using mobile apps, and making phone calls, etc.

	 2.	 PACE, Titan, Sunway Taihulight and Pratyush are the examples of Supercomputer.
	 3.	 Table is very useful in enhancing and analyzing the data in Word. 
	 4.	 Merged Document is the final document created by merging the Main Document and Data 

Source.
	 5.	 The Notes Page view shows user how notes pages look like in printed form. In this view, 

slide of our presentation and the speaker notes that we have added within the Notes pane 
for each individual slide appear together.

B.	 1.	 A low-level language is a programming languages that is machine dependent. A program 
written in machine dependent language runs only on one particular type of computer. 

	 Two low-level languages are: Machine Language and Assembly Language.  
	 2.	 A file extension is a group of two or more characters used to identify the type of a file. Two 

examples are: .jpeg and .mp3.
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	 3.	 With the Table Styles feature, you can format the entire table quickly. You can apply any 
style to your table from the Table Styles feature. There are many built-in table styles present 
in Word. 

		  Steps to apply a table style:
		  Step 1	 Click anywhere on the table. The Design tab appears on the ribbon.
		  Step 2	� Click and select the design of your choice from the Table Styles group. The selected 

style will be applied to the table.
	 4.	 Three advantages of Mail Merge are:
	 (i)	 It saves time and efforts.

	 (ii)	 It allows to make changes in several letters very quickly.
	 (iii)	It allows to produce thousands of letters quickly.

	 5.	 Reading View is used when you want to view a presentation not in fullscreen but in a 
window with simple controls that make the presentation easy to review. 

		  Slide Sorter View shows all the slides of a presentation in a miniature version and allows 
to change their order. 

 Scratch Programming—Game Creation

OneOne LearnTouch

A.	 1.	 c.	 2.	 b.	 3.	 c.	 4.	 a.	  5.	 a.

B.	 1.	 F	 2.	 F	 3.	 F	 4.	 T	 5.	 T

C.	 1.	 Pen	 2.	 regular	 3.	 stamp	 4.	 sound	 5.	 operators

D.	 1.	 Control block			   2.	 Looks block

	 3.	 Motion block			   4.	 Events block

ItLet's Do

A.	 1.	 Pen blocks in Scratch allow a Sprite to draw shapes and plot coloured pixels on the screen.
	 2.	 Three types of Operators are Arithmetic operators, Relational operators and Logical 

operators.
	 3.	 Repeat block is used to draw a pentagon.
	 4.	 Two conditional control blocks are: Forever and Forever–if.

6.
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B.	 1.	 The four methods to choose a sprite are:
	 (i)	 Paint a new sprite
	 (ii)	 Choose a sprite from the library
	 (iii)	Upload a sprite from file
	 (iv)	Surprise
	 2.	 The Repeat block is used to run a set of instructions for a specified number of times. 

Whereas the Forever block is used to run a set of instructions continuously until stopped. 
The instructions inside this block will be executed in a loop until the Stop button is clicked 
by the user. 

C.	 1.	 To allow a sprite to draw shapes by going to where the mouse is clicked, Mohit should 
create the following script:

	 2.	 To create a Scratch game for picking up garbage from the stage, Sam should use the 
following blocks for these purposes:

		    �Movement: Use the ‘when [key] pressed’ block along with ‘change x/y by’ blocks to 
move the player sprite using arrow keys.

		    �Garbage: Create garbage using clones with ‘create clone of [myself]’, place them randomly 
with ‘go to x/y’, and use ‘delete this clone’ when the player touches the garbage.

		    �Scoring: Create a score variable and use ‘change [score] by 1’ when garbage is collected.
		    �Optional Timer: use the ‘timer’ block to add a time limit.
Higher Order Thinking Skills (HOTS) 
	 1.	 To add sound effects or music to Scratch project use Sound block category from the Code 

tab.
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	 2.	 Pankaj should make the following correction in his script:

Crack CodeThe
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Do it yourself. 

 HTML—An Introduction

OneOne LearnTouch

A.	 1.	 a.	 2.	 b.	 3.	 c.	 4.	 d.	 5.	 d.
B.	 1.	 F	 2.	 F	 3.	 T	 4.	 F	 5.	 T
C.	 1.	 markup 	 2.	 Empty 	 3.	 Body	 4.	 Inline	 5.	 Background-image

7.
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ItLet's Do

A.	 1.	 HTML5 is the latest version of HTML.
	 2.	 Selector refers to an HTML tag to which a style will be applied.
	 3.	 A tag that has an opening tag, content, and a closing tag is called a container tag.
	 4.	 A property that provides additional information about a tag is called an attribute.
B.	 1.	 HTML stands for Hypertext Markup Language. It is a markup language that describes the 

structure of a web page. It allows us to create web pages that contain paragraphs, headings, 
links and block quotes. 

	 2.	 <!DOCTYPE html>
		  <html>

		  <head>

		    <title>My Web Page</title>

		    <link rel=”stylesheet” href=”mystyle.css”>

		  </head>

		  <body>

		    <h1>Welcome to my page!</h1>

		    <p>This page uses a custom stylesheet.</p>

		  </body>

		  </html>

	 3.	 An internal style sheet is commonly used when one web page has a unique style. 
C.	 1.	 Purpose: ALIGN attribute specifies how content inside an element (like text, images, or 

tables) should be aligned, whereas CENTER tag centers the entire content inside it (like 
text or images) horizontally on the web page.

		  Similarities: Both the ALIGN attribute and the CENTER tag in HTML are used for aligning 
content on a webpage.

		  Differences: The ALIGN attribute is used within specific HTML tags such as <p>, <div>, 
<img>, or <table> to define how content within those tags should be aligned—left, right, 
center, or justify, Whereas the CENTER tag only centers content horizontally and offers less 
flexibility.

	 2.	 Chinmay should follow these steps to edit an HTML document: 
		  Step 1	 Right-click on the HTML file. 
		  Step 2	 Click on the Open with option. 
		  Step 3	 Click on Notepad. 
Higher Order Thinking Skills (HOTS) 
	 1.	 Block Level tags: <P>, <H2>, <HR>
		  Text Level tags: <SUB>, <B>
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	 2.	 Text Editor is used to write and edit HTML code whereas Microsoft Edge is used to view 
and test the webpage. 
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Do it yourself.

 Online Surfing and Cyber Security

OneOne LearnTouch

A.	 1.	 d.	 2.	 a.	 3.	 c.	 4.	 d.	 5.	 a.
B.	 1.	 T	 2.	 F	 3.	 F	 4.	 T	 5.	 T
C.	 1.	 Carding	 2.	 E-greeting	 3.	 Chat	 4.	 cyber security 

ItLet's Do

A.	 1.	 Phreaking crime is committed against telephone companies by using computers with the 
goal of making free distance calls, impersonating directory assistance or other operator 
services, diverting calls to numbers of the perpetrator’s choice, or tapping phone lines.

	 2.	 A newsgroup is an online discussion group where people talk about a specific topic. Everyone 
in the group is interested in the same topic and shares their thoughts and ideas. 

	 3.	 Use of social networking services is not advisable for students because these services are 
generally considered as a source of distraction from education for students.

	 4.	 A cloud storage is a service where the users are able to store and manage data on remote 
server in place of their local computer.

8.
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B.	 1.	 Four Safety measure while using Internet services are:
	 (i)	� Never provide personal information, such as address, phone number, or school name 

or location.
	 (ii)	 Keep our browser’s privacy settings ON.
	 (iii)	Use the Internet only in the presence of our elders.
	 (iv)	Do not share passwords (other than our parents or teachers).

	 2.	 Different types of Communication techniques are:
	 (i)	� E-mail: E-mail stands for electronic mail. We can send messages and files from our 

computer to your friend’s computer and vice-versa using e-mail service. It is fast and 
generally delivered within few seconds (depending on the network speed) after sending. 

	 (ii)	� Video Conferencing: We use telephones and mobiles to talk to our friends and relatives. 
With the advancement in technology, we can now see the person with whom we are 
talking. The technique of watching the person while talking to him is called video 
conferencing. In video conferencing, there can be two or more persons at different 
locations simultaneously talking to each other by both audio as well as video.

	 (iii)	� Voice-over-Internet Protocol (VoIP): Voice-over-Internet Protocol (VoIP) is a 
technology which gives a calling facility over the Internet. This service is used to transfer 
voice, fax, and multimedia content. 

	 3.	 The differences between hacking and cracking are:

	
Hacking Cracking

a. �Hacking is when someone accesses 
someone else’s computer or account 
without permission. 

a. �The process of stealing personal 
information, changing financial data, 
and breaking security systems to gain 
unauthorised access to computer 
systems is called cracking. 

b. �People who engage in computer 
hacking activities are often called 
hackers. 

b. �The people who are involved in the 
process of cracking are called crackers. 

	 4.	 There are various types of cyber threats. Some of them are as follows:
	 (i)	� Data Diddling: Refers to the process of changing the data going into or out of a 

computer. 
	 (ii)	� Phreaking: This crime is committed against telephone companies by using 

computers with the goal of making free distance calls or tapping phone lines.
	 (iii)	�Cloning: This refers to a fraud in which scanners are used to steal the electronic serial 

numbers of cellular phones, which may used for billing purposes and making broadcast 
calls. 
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	 (iv)	�Carding: This refers to the process of stealing credit card numbers online, to be resold 
or used to charge merchandise against victim’s account.

	 (v)	� Hacking: Computer hacking is the practice of modifying computer hardware and 
software to accomplish a goal outside of the creator’s original purpose. 

	 (vi)	�Cracking: The process or stealing personal information, changing financial data, breaking 
security systems to gain unauthorized access of computer systems is called cracking. 

C.	 1.	 Arun can use the e-banking facility to transfer funds easily and quickly from one account 
to another.

		  E-banking offers the following benefits:
		    Convenient banking
		    No geographical restrictions
		    Lower costs
		    Reduced chances of fraud 
	 2.	 No, this was not the right action.
		  Nishant should have:
		    Informed the teacher honestly about the missed deadline.
		    Requested permission to submit the project late.
		    Used his own email account to send the project.
Higher Order Thinking Skills (HOTS) 
	 1. 	 Following are some of the important guidelines you should remember while using Internet 

services: 
		    �Never provide personal information, such as address, phone number, or school name or 

location. 
		    Keep your browser’s privacy settings ON. 
		    Use the Internet only in the presence of your elders. 
		    Do not share passwords (other than your parents or teachers). 
		    Never meet anyone you’ve met online without your parents’ permission or supervision. 
		    Never respond to a unknown e-mail, message, post, or text. 
	 2.	 Using all capital letters in an email sounds like you’re shouting. It’s considered rude or 

aggressive. It’s better to write in normal sentence case so your message looks polite and 
respectful.
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Do it yourself.

 E-mail—An Introduction

OneOne LearnTouch

A.	 1.	 c.	 2.	 a.	 3.	 d.	 4.	 b.	 5.	 c.	 6.	 c.
B.	 1.	 F	 2.	 T	 3.	 F	 4.	 F	 5.	 T	 6.	 F
C.	 1.	 Bcc 	 2.	 To  	 3.	 Cc	 4.	 Subject	 5.	 Sent  

ItLet's Do

A.	 1.	 Internet is a computer network that connects hosts and end systems throughout the world.
	 2.	 We use emoticons to represent facial expressions.
	 3.	 Yes, we can send a video file as attachment in an e-mail.
	 4.	 An electronic mail or e-mail can be defined as the process of exchanging messages 

electronically through a communications network by clicking on it.
B.	 1.	� Signing in or Logging in is the process of accessing your e-mail account by providing the 

username and password.

9.
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	 2.		 E-mail has various advantages, some of them are:
	   An e-mail can be sent anytime and from anywhere in the world.
	   An e-mail can be sent to many people at a time.
	   An e-mail can be easily forwarded to anyone without typing it again.
	   Sending an e-mail is fast in comparison to traditional mails.
	 3.	 E-mail has several features. Some of them are as follows:
	   Send and receive messages quickly to anyone around the world. 
	   Attach files like documents, pictures, and videos to your emails. (MIME type of files) 
	   Store and organise email addresses of your friends, family, and contacts. 
	   Organise your emails into different categories or topics. 

C.	 1.	 Sumit can attach the music file by clicking the “Attach files” button at the bottom of the 
New Message window.

	 2.	 Sushant can write the recipients’ email addresses in the BCC field to keep their identities 
confidential from one another.

Higher Order Thinking Skills (HOTS) 
	 1.	 armeet@gmail.com
	 2.	 The Subject field contains a one-line introduction that briefly explains the purpose of the 

email. It gives the recipient an idea of what the email is about.
	 3.	 Raman should Sign out properly from his e-mail account after using it so that others cannot 

misuse his it.
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Do it yourself. 

 More on Internet

OneOne LearnTouch

A.	 1.	 a.	 2.	 a.	 3.	 c.	 4.	 d.	 5.	 a.

B.	 1.	 F	 2.	 T	 3.	 T	 4	 F	 5.	 T
C.	 1.	 Blog	 2.	 Blogger	 3.	 Online	 4.	 Cash on delivery	 5.	 Drive

ItLet's Do

A.	 1.	 Google Docs option is used to create word file on Google Drive.
	 2.	 Two modes of payment are Net Banking and E-Wallet.
	 3.	 OTP stands for One Time Password.
	 4.	 Two e-commerce websites are www.amazon.com and www.flipkart.com.
B.	 1.	 A blog or weblog is an informational website that often contains information on a particular 

subject. Podcasts and Photologs are types of blogs.
	 2.	 The process of making digital recordings (audio or video) that are available for downloading 

is called podcasting.
		  Podcasting services are https://itsamonkey.com/ and http://revisionisthistory.com.
	 3.	 E-commerce has several advantages. Some of them are:
	 (i)	 It allows us to choose a product from a broad range of products.
	 (ii)	 It saves our money and time.
	 (iii)	 It allows us to sell or buy products and services at any time.
C.	 1.	 Ritu can pulish her article on various blogging platforms such as: WordPress, Blogger, 

Tumblr, etc.
	 2.	 Alia can use cloud storage services to store and access her files from anywhere without 

carrying a laptop or external hard disk.
Higher Order Thinking Skills (HOTS)
	 1.	 Google Drive allows us to share the uploaded files with others so that they can also access 

your files. To share a file or folder, follow these steps: 
		  Step 1	 Select the file which you want to share with others. 

10.
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		  Step 2	 Click on the Share button. The Share dialog box appears. 
		  Step 3	� Write the e-mail addresses or names of the people you want to share within the 

Add people, groups and calender events text box. 
		  Step 4	 Click on the Done button. 
	 2.	 Similarities: Physical stores and E-commerce websites both offer a variety of choices and 

allow you to buy products of your choice.
		  Differences: In a physical store, you can touch and try items and purchase them instantly. 

Whereas, on e-commerce websites, you can shop from home at any time, get the product 
delivered to your doorstep, and pay online.

		  I prefer e-commerce for its convenience and time-saving.
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B.	 1.	 E-commerce website	 2.	 Blog
	 3.	 Google Drive 			   4.	 Blogging
	 5.	 CVV			   6.	 Net banking
	 7.	 Blogger			   8.	 WordPress
	 9.	 Podcasting			   10.	 Cloud storage

Do it yourself. 

Worksheet–2
(Based on chapters 6 to 10)

A.	 1.	 Backdrop is a background of the stage.
	 2.	 Sprite is an object that we see on the scratch stage.
	 3.	 Stage is the main working area to draw or perform action. It shows the output of the 

program.
	 4.	 Scripts area is the area where we pick and drop the blocks from the Blocks Palette to create 

a script/program.
	 5.	 Green Flag is used to run a scratch program.
B.	 1.	 Adobe Dreamweaver		  Amaya
	 2.	 <BR>				    <HR>
	 3.	 Communication			   E-Banking
	 4.	 Net Banking				    E-Wallet
C.	 1.	 set pen color to ()
	 2.	 Stamp
	 3.	 Web browser
	 4.	 Container Tag	
	 5.	 Attribute
	 6.	 Newsgroup
	 7.	 Cloud Storage
	 8.	 Spam
D.	 1.	 Hyper Text Markup Language
	 2.	 Standard Generalized Markup Language
	 3.		 Card Verification Value
	 4.	 One Time Password
	 5.	 Common Business Oriented Language
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Test Sheet–2
(Based on chapters 6 to 10)

Section A
A.	 1.	 a.	 2.	 c.	 3.	 a.	 4.	 d.

	 5.	 d.	 6.	 d.	 7.	 a.	 8.	 b.

B.	 1.	 F	 2.	 T	 3.	 F	 4.	 T	 5.	 F

C.	 1.	 Sounds	 2.	 Body	 3.	 E-greeting	 4.	 Outbox	 5.	 Google

Section B
A.	 1.	 Repeat Block is used to draw a Pentagon.

	 2.	 Empty tags contain only opening tag. They do not have closing tag.

	 3.	 In place of </h4>, </h1> should be used.

	 4.	 Hacking is the practice of modifying computer hardware and software to accomplish a goal 
outside of the creator’s original purpose.

	 5.	 Compose button on Gmail is used to create and type a new mail.

	 6.	 The meaning of F9 acronym in an e-mail is Fine.

	 7.	 E-commerce is a broad term that refers to buying and selling goods or services online, 
including business transactions, marketing, online payments, etc. Whereas, online shopping 
is a part of e-commerce that specifically means buying products from websites or apps.

B.	 1.	 Blocks are puzzle piece shapes that are used to give instructions to the computer.
	 Four pen blocks are:

	 (i)	 Pen up

	 (ii)	 Pen down

	 (iii)	Stamp

	 (iv)	Set pen color to

	 2.	 The <Body> tag tells the web browser that the text contained between <Body> and  
</Body> tags is to be shown on the web page. It is container tag. Two attributes are:

	 (i)	 BGCOLOR 

	 (ii)	 TEXT

	 3.	 <html>

	 <head> </head>

	 <body>

	 Chemical formula for Sulphuric acid is H<sub>2</sub>SO<sub>4</sub>.
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	 <BR> Maths formula for (A + B) <sup>2</sup> is A<sup>2</sup> + B<sup>2</sup>  
+ 2AB.

	 </body>

	 </html>

	 4.	 Four Safety Measures while using Internet are:

	 (i)	� Never provide personal information, such as address, phone number, or school name 
or location.

	 (ii)	� Keep the browser’s privacy settings ON.

	 (iii)	� Use the Internet only in the presence of the elders.

	 (iv)	�Do not share passwords (other than the parents or teachers).

	 5.	 orangeeducation123 is the user name and gmail.com is domain name.
	 6.	 The process of buying and selling goods or services online is called e-commerce. The 

e-commerce is also known as electronic commerce.
	 The three Payment modes are:
	 i.	 Debit or Credit Card
	 ii.	 Net Banking
	 iii.	 E-Wallet


